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This software manual is only valid in combination with the following oper‐
ating and supplementary instructions:

n Multi-channel measuring and control system operating instructions
DULCOMARIN® II Swimming Pool Controller and Disinfection Con‐
troller DXCa Part 2: Operation

In order to make it easier to read, this document uses the male form in
grammatical structures but with an implied neutral sense. It is aimed
equally at both men and women. We kindly ask female readers for their
understanding in this simplification of the text.

Please read the supplementary information in its entirety.

The following are highlighted separately in the document:

n Enumerated lists

Instructions

ð Outcome of the instructions

Information

This provides important information relating to the cor‐
rect operation of the system or is intended to make your
work easier.

Safety information

The safety information includes detailed descriptions of the hazardous sit‐
uation.

Reproduction of Windows® XP professional screen-shots with the kind per‐
mission of the Microsoft® Corporation.

Further applicable documents

General non-discriminatory approach

Supplementary information

Windows® XP professional

Supplemental directives
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1 Embedded Web Server, LAN for DULCOMARIN II DULCO-
Net

1.1 About this product

To read out the identity code, press the function key F1
[HELP] in the central menu item.

By use of the Embedded Web Server in the DULCOMARIN® II
DULCO®-Net the central unit of the DULCOMARIN® II can be remotely
controlled from a PC.

Moreover, the PC can be used to change the setpoints and stop and start
dosing.

The central unit of the DULCOMARIN® II and the PC can be linked
together via a LAN. Access to the embedded web server is password-pro‐
tected.

The embedded web server is available with the DULCOMARIN® II
DULCO®-Net with identity code characteristic „communication interfaces:
5, 8, 9 Embedded Server, LAN“  in the identity code of the central unit
(DXCa_ _5 1 _ _ _ _ _ _01).

1.2 Network security

WARNING!
Excess chlorine, acidification or hygiene deficits
Possible incorrect operation of the controller due to
external attack on the LAN.

Remedy: When connecting to a LAN, ensure there is
sufficient security. Observe the basic rules relating to
network security.

Protect the embedded web server with 2 secure pass‐
words of maximum character length (use numbers and
special characters as well).

The central unit of the DULCOMARIN® II must be pro‐
tected by secure passwords. The PIN card (order no.
986894), assists in recording multiple passwords.

Before commissioning the DULCOMARIN® II network connection, it must
be checked as part of the operator's duty of care, whether the installation
can cause particular interactions with existing data processing systems.

In addition, the central unit of the DULCOMARIN® II must be protected
against unauthorised access by the entry of secure passwords and the
DULCOMARIN® II Web server by the entry of two secure passwords. If the
customer does not enter a secure password, then he releases ProMinent
from any claim for damages, which can be traced back to unauthorised or
incorrect data transfer and data utilisation.

The operator is responsible for ensuring appropriate backing up of existing
data prior to first commissioning and during ongoing operation. In the
event of a suspected error all conceivable protection measures must be
taken.

ProMinent is not liable for damages due to force majeure (civil distur‐
bances, war, natural disasters) or arising from other events which are not
the responsibility of ProMinent (power cut, traffic congestion, maintenance
or repair work of malfunctions of IT systems and Internet connections).

Usage clause

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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1.3 Installation and set-up

Microsoft® Internet Explorer is a registered trademark or
trade name of the Microsoft® Corporation in the USA
and/or other countries.

PC requirements

n Browser (e.g. Microsoft® Internet Explorer): must be running
n Network card: must be fitted

Firstly physically connect the DULCOMARIN® II central unit to the PC, as
described in the following chapters.

1.3.1 Via a direct connection

A0860

Fig. 1: Direct connection of the DULCOMARIN® II and PC
The DULCOMARIN® II can be directly connected to the PC, using the LAN
M12-RJ45 patch cable (1) together with a LAN coupler (2) and a cross-
over cable (3).

LAN M12-RJ45 patch cable, necessary for connection of
the DULCOMARIN ® II (contained in the scope of
supply).
The M12 threaded connector of the LAN M12-RJ45
patch cable is only moisture-tight when tightened up.
Therefore in wet areas, protect the M12 connector of the
DULCOMARIN ® II with the supplied protective cap until
the LAN patch cable is properly connected.
If the DULCOMARIN® II is connected to the PC via the
LAN cable, then the LAN LED illuminates on the
DULCOMARIN® II (the rightmost of the four LEDs).

Installation equipment Part no.

LAN M12 - RJ45 patch cable, 5.0 m in the scope of supply

LAN M12 - RJ45 patch cable, 10 m 1026716

LAN RJ45 patch cable, cross-over, 3.0 m 1027859

LAN coupler, RJ45 1027860

Installation

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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NOTICE!
You can operate the DULCOMARIN® II with only one
password.

Use two passwords to provide stronger protection of the
DULCOMARIN® II. One password each for read and
write access.

You can protect the „Embedded Web Server“  with two
passwords. You can set up a maximum of 8 users (also
use the maximum number of characters for this pur‐
pose).
Under the [WEB] tab for passwords, you can set under
[Access], whether the password only allows [Read] , or
[Write] access or both. Using the [UP] and [DOWN] keys
you can select the desired characters.

1. Change to the central unit of the DULCOMARIN® II by pressing the
[ENTER] key of the continuous display in the central menu item.

A0861

Fig. 2: Web server settings IP address (DULCOMARIN® II)
2. From the central menu item, press F4 [CONFIG] and F2 [OPTION ]

to call up the [WEB] tab

3. Check the IP address of the DULCOMARIN® II [192.168.30.1]. The
gateway address must be identical to it for this type of installation

Adjustment

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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A0862

Fig. 3: [Network connections]
4. Access the PC IP settings menu (see the documentation for your

PC operating system).

For example, the path for Microsoft® Windows XP Professional SP2
is: [Start] ➨ [Control Panel] ➨ [Network and Internet Connections]
➨ [Network Connections]:

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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5. In this Window click on the icon [LAN or High-Speed Internet]

ð [The status of the LAN connections] appears under [General].

A0863

Fig. 4: Status of LAN connections.

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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6. In this Window click on the [Properties] ➨

ð [The LAN connection properties] appear.

A0864

Fig. 5: LAN connection properties.
7. In this Window select [Internet Protocol (TCP/IP)]

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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8. Click on [Properties]

ð [The Internet Protocol (TCP/IP) properties] appear

A0865

Fig. 6: Internet Protocol (TCP/IP) properties
9. Enter the following values in this window:

n [IP address]: [192.168.30.2] (Note here that the [2] at the end
must be different from the corresponding value of the IP
address of the DULCOMARIN® II in this position)

n [Subnet mask]: [255.255.255.0]
n Do not change the [Default gateway]. The [Default gateway] is

dependent on your network.

10. Click [OK].
11. Close all the Control Panel windows

12. Change to the DULCOMARIN® II to the [WEB] tab and press the F4
key [PASSW] to access Password entry

13.
You must enter a User and Password that differ
from the default settings for the
DULCOMARIN® II.

To do this, press the [ENTER] key, then use the arrow keys to
select the characters

Press the [ENTER] key again

14. Then press F5 [SAVE]

ð otherwise the entries are lost.

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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Fig. 7: Web server settings Password (DULCOMARIN® II)
15. From the central menu item, press F4 [CONFIG] and F2 [OPTION ]

to call up the [WEB] tab.

Press the F3 [RESET] key to activate the changed data.

ð The system restarts.

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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If you have successfully installed and adjusted every‐
thing up until now, proceed as follows:

1. Open the PC browser (e.g. Microsoft® Internet Explorer)

2. Then in the address line enter the IP address of the
DULCOMARIN® II: [192.168.30.1]

ð an authentication window appears.

3. Enter the username [User] and password [Password] in the authen‐
tication window

ð The web interface of the DULCOMARIN® II with the continuous
display appears on the PC screen

A0867

Fig. 8: Web interface (DULCOMARIN® II)

If the web interface does not appear:
Check that Microsoft® Internet Explorer is not
using a proxy server. In the Browser under
[Tools] ➨ [Internet options] ➨ tab:
[Connections] ➨ [LAN settings] check that the
[Proxy server ] check box is not ticked. If it is,
then remove the tick and exit the menus by
clicking [OK] and then re-enter the IP address
of the DULCOMARIN® in the address line and
click [Change to].

Results checking

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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1.3.2 Via a LAN

A0868

Fig. 9: Connection of the DULCOMARIN® II and PC via a LAN
The DULCOMARIN® II can be connected to the PC like a normal web
server.

NOTICE!
Only the network supervisor (specialist) who is normally
responsible for the LAN may make the connection.

Only he will have sufficient knowledge of the LAN and
the necessary specialist know-how.

The following text contains information about the
DULCOMARIN® II that will only be needed by network
specialists to install and set it up.

NOTICE!
You can operate the DULCOMARIN® II with only one
password.

Use two passwords to provide stronger protection of the
DULCOMARIN® II. One password each for read and
write access.

You can protect the „Embedded Web Server“  with two
passwords. You can set up a maximum of 8 users (also
use the maximum number of characters for this pur‐
pose).
Under the [WEB] tab for passwords, you can set under
[Access], whether the password only allows [Read] , or
[Write] access or both. Using the [UP] and [DOWN] keys
you can select the desired characters.

Installation

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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LAN M12-RJ45 patch cable, necessary for connection of
the DULCOMARIN ® II (contained in the scope of
supply).
The M12 threaded connector of the LAN M12-RJ45
patch cable is only moisture-tight when tightened up.
Therefore in wet areas, protect the M12 connector of the
DULCOMARIN ® II with the supplied protective cap until
the LAN patch cable is properly connected.
If the DULCOMARIN® II is connected to the PC via the
LAN patch cable and an Ethernet socket is connected to
the network switch, the LAN LED then illuminates on the
DULCOMARIN® II (the rightmost of the four LEDs).

Installation equipment Part no.

LAN M12 - RJ45 patch cable, 5.0 m in the scope of supply

LAN M12 - RJ45 patch cable, 10 m 1026716

1. Change to the central unit of the DULCOMARIN® II by pressing the
[ENTER] key of the continuous display in the central menu item.

2. From the central menu item, press F4 [CONFIG] and F2 [OPTION ]
to call up the [WEB] tab

A0861

Fig. 10: Web server settings IP address (DULCOMARIN® II)
3. The tab WEB indicates:

n the IP address of the DULCOMARIN® II (ex works:
192.168.30.1)

n the gateway address (ex works: 192.168.30.1)

4. Use the [ENTER] key and the arrow keys to change the settings

5. Save the settings by pressing F5 [SAVE]
6. Access the PC IP settings menu (see the documentation for your

PC operating system).

For example, the path for Microsoft® Windows XP Professional SP2
is: [Start] ➨ [Control Panel] ➨ [Network and Internet Connections]
➨ [Network Connections] ➨ [LAN Connections] ➨ [Properties] ➨
[Internet Protocol] ➨ [Properties]

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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7. Enter the following values in this window:

n [IP address]
n [Subnet mask]
n [Default gateway]

8. Click [OK].
9. Close all the Control Panel windows

10. Change to the DULCOMARIN® II to the [WEB] tab and press the F4
key [PASSW] to access Password entry

Fig. 11: Web server settings Password (DULCOMARIN® II)
11. Enter the desired user (Username) and password (Password) for

the DULCOMARIN® II.

To do this, press the [ENTER] key and use the arrow keys. Press
the [ENTER] key again

12. Then press F5 [SAVE]

ð otherwise the entries are lost.

1.4 Operation
1.4.1 Operating elements and operating language

If the mouse is faulty, you can also use the [Tab] key
and [ENTER] key to navigate.

The web interface is designed for navigating using the mouse. The func‐
tion of the [ESC] key of the DULCOMARIN® II acts as a link [back] (jumps
up in the operating menu hierarchy).

1. Jump to the web interface in the continuous display

2. Select the operating language using the radio buttons beneath the
two flags.

3. To make a selection press the [Select] key

Operating elements

Setting the operating language

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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1.4.2 Layout of the operating menu

A0869

Fig. 12: Layout of the web interface operating menu
The layout of the web interface operating menu is essentially the same as
the layout of the layout menu of the DULCOMARIN® II itself.

However it is also possible to jump directly to the parameter configuration
of a measured variable directly from the central menu item (roughly analo‐
gous to the measured variable tabs).

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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1.4.3 Read

If the following message appears
[Change not possible ...] , then someone is operating the
device directly from the operating menu.

The continuous display and the central menu item of the web interface are
equivalent to their counterparts in the DULCOMARIN® II.

They display almost the same number of instantaneous measured values,
control variables and also the dosing state for a certain pool. Here it is also
possible to select another pool.

Only with [Recorder active]: At the bottom left of the continuous display the
link [System overview] appears. The allocated page shows the measured
values for all pools (actual values), the setpoints and the control state
(updated every 5 minutes).

Error messages only appear in the error list [LIST].
The opened error list does not update automatically. Use
the browser [Update] function to manually update the
error list.
Time and date differences between the web interface
and DULCOMARIN® II are possible (for example when
changing over to summer time). The time and date dis‐
played originate from the PC, not the DULCOMARIN® II.
The DULCOMARIN® II automatically updates the dis‐
played values every 20s. The values can also be man‐
ually updated using the browser [Update] function.

To change to the central menu item, you must click any link in the contin‐
uous display.

In the central menu item the operating menu branches out.

The following displays of the web interface subdivide the data in a manner
analogous to the DULCOMARIN ® II into:

n Calibration
n Parameterisation
n Configuration

Within the data displays, the data divides into two areas:

n The top area shows the set parameters
n The bottom area shows the value ranges of the parameters

Only the [Setpoint Setting ...] display has a middle area for the settable
parameters.

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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A0870

Fig. 13: Areas of a display (DULCOMARIN® II): set parameters - top, value
ranges - bottom

1.4.4 Write (Change)

The set value only becomes effective upon clicking the
key [Select].

If the following message appears
[Change not possible ...] , then someone is operating the
device directly from the operating menu.

In the display [Setpoint setting...] the control state can be changed and the
setpoints adjusted.

1.5 Accessories
 Part no.

LAN M12 - RJ45 patch cable, 5.0 m 1026715 (in the scope of
supply)

LAN M12 - RJ45 patch cable, 10 m 1026716

LAN RJ45 patch cable, cross-over, 3.0 m 1027859

LAN coupler, RJ45 1027860

LAN adapter IP67 DXC, complete 1024835

PIN card 986894

Embedded Web Server, LAN for DULCOMARIN II DULCO-Net
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2 Manual ProMinent OPC-Server
2.1 OPC Foreword

This user manual forms part of the documentation for the ProMinent OPC
server software The purpose of the manual is to guide the user through:

n Software installation
n Software commissioning
n Software configuration

The manual revision is 31/03/2011.

The manual applies to the ProMinent OPC-Server Version 1.0.4.1

2.2 Introduction

You can find more information about OPC technology
under: www.opcfoundation.org

2.2.1 What is OPC?
OPC stands for Openness, Productivity, Collaboration (formerly OLE for
Process Control) and is used to describe a uniform software interface
independent of specific manufacturers.

OPC Data Access (OPC DA) is based on Windows technology COM
(Component Object Model) and DCOM (Distributed Component Object
Model).

OPC XML, by contrast, is based on the internet standards XML, SOAP
and HTTP.

2.2.2 What is DCOM?
For communication between individual applications, OPC currently mainly
uses Microsoft DCOM technology (Distributed Component Object Model).
DCOM extends COM by adding network functionality.

The installation CD also includes a more detailed document from the
OPC-Foundation with fundamental information on the use of DCOM under
Windows XP and system configuration.

2.2.3 What is XML-DA?

Advice on operation with XML-DA
The OPC server cannot be started via the OPC client if
XML-DA is used. This is technically not feasible.
The OPC server should also not be started using
DCOM, if XML-DA is to be used, as the ending of all
COM-DA clients also closes the OPC server.
To use XML-DA, manual starting of the OPC server is
recommended.

Purpose of the manual

Manual revision

Extent of validity of the manual

Manual ProMinent OPC-Server
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Communication over DCOM is limited to the local network.

Data exchange via XML enables communication using the platform inde‐
pendent SOAP protocol via Internet/intranet. OPC-XML-DA represents the
first creation of a web service based interface.

The functionality is similar to the normal data access interface, which is the
first, and remains the most important OPC interface.

Using the web service, OPC is also available on other platforms such as
Linux. Many manufacturers of OPC servers initially developed adapters,
which simply map OPC XML-DA calls to the existing COM OPC DA
servers.

In contrast to DCOM, web services use port 80 (HTTP) which also makes
its easier to communicate through firewalls or to tunnel data traffic.

2.3 ProMinent OPC-Server installation
2.3.1 Operating diagram and operating elements

System requirements:

n Supported operating systems: Windows 2000 Service Pack 3; Win‐
dows Server 2003; Windows XP Service Pack 2; Windows Vista; Win‐
dows 7

n Windows Installer 3.0
n .NET Framework 2.0
n 512 MB RAM is recommended as a minimum.

The OPC server supports the following OPC standards:

n Data access DA, DA2, DA3
n XML-DA (must be activated by USB hardlock)

Scope of installation:

n The installation requires approximately 3.5 MB.
n In addition, several OPC system components such as Softing License

Manager are installed.

2.3.2 Installation
Start the setup by double-clicking [OPCServer-Setup.exe]. A wizard
guides you through the installation step by step. If not already installed, .
[NET Framework 2.0 setup], which is included on the installation CD, will
be run during the installation process.

2.4 Quick start
2.4.1 Basic principles

The OPC server essentially comprises two components; namely the actual
OPC Server which is started by the OPC Client and with which it
exchanges data. This is done in operation with a visualisation or soft PLC
mainly in the background, i.e. invisible to the user. For the OPC server to
exchange data, it must first be configured. To carry this out, the OPC
server provides a user-friendly graphical Windows user interface as the
second component. Once the OPC server has been configured, the user
interface is primarily only needed for commissioning, not for operation
using an OPC client.

The configuration and data communication between OPC client and OPC
server is accomplished in three consecutive steps:

Manual ProMinent OPC-Server
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Start the ProMinent OPC server by double-clicking on the desktop
icon or from the start menu under All Programs ➨ ProMinent OPC-
Server ➨ ProMinent OPC-Server

1. Click on the [+] icon in the toolbar or select [Add device] from the
[Edit] menu.

2. In the following dialogue, enter the device name, the required user
name, the password as well as the IP address and the port of the
device which are required for access.

ð Confirm all entries by pressing [OK].

3.
The device is now included in the project struc‐
ture, finally the device configuration is loaded.
Loading of the device configuration takes between
a few seconds and one minute, depending on the
size of the system.

To save the project select [Save] from the [File] menu or press the
key combination [Ctrl+S].

ð The configuration is saved as an XML file the file type [OPC].

The project structure (OPC namespace) can now be
accessed via the OPC client and you can now start to
further process the data or portray it using visualisation
software.

A0844

Fig. 14: OPC server and client installed on one PC.

A0845

Fig. 15: OPC server and client installed on networked PCs.

Starting

Adding a device

Saving the project

Linking the OPC client
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2.5 Program functions
2.5.1 Main interface

Configuration of the OPC server takes place in a clearly laid-out window
similar to a window used by MS-Windows' Windows Explorer. The por‐
trayal of the devices up to and including the measured values is achieved
using a tree structure.

A0846

Fig. 16: Main interface
The program window is divided into four areas:

n The menu and toolbar at the top
n The tree structure with devices and their data points are shown on the

left
n Details relating to the data points are shown on the right.
n The status bar is shown at the bottom of the window

the devices with their data points are presented in the left window area.
Clicking a [+] icon expands the tree structure. The selection of possible
tool and menu functions changes dependent on whether a device itself or
a data point has been selected.

Details relating to the relevant selected data point are shown in the right
part of the window. If a group of measured values was selected in the left
window area, e.g. [Measured value], the list of the measured values with
description, [Property], actual value [Value], timestamp [Timestamp],
quality [Quality] and data type [Type] is displayed in the right window area.

If a measured value itself was selected, its specific properties [Property]
are shown on the right window side.

[Property] on the right window side identifies the measured value con‐
cerned. The column [Value] shows the current value for this measured
value. The column [Timestamp] indicates when this value last changed.

[Quality] indicates how reliable the value is. A [GOOD] quality means the
value was successfully updated during the last update. If the quality is
[BAD] the value was not received by the device. The quality
[LAST_KNOWN] indicates that no data point update has taken place since
loading of the configuration and that the measured value thus originates
from the locally saved configuration file.

The column [Type] shows the data type of the measured value. The data
type [String] is a simple character string; [Double] refers to high internal
accuracy floating point numbers. The data types [Int] or [UInt] may occur
infrequently; these are integers in certain value ranges.

The status of the device is also indicated by the colour highlighting of the
device name in the tree view on the left side.

n Green
– Updating of the data points was successful

n Red

Manual ProMinent OPC-Server
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– An error occurred during updating of the data points. There is
possibly no longer a connection to the device.

2.5.2 Menu

New Creates a new project. Unsaved changes are lost
Open Loads an existing project
Save Saves the current project
Save as... Saves the current project under a specified name
End Closes the OPC server

Add device Opens the add new device dialogue
Delete device Deletes the selected device from the project
Load device con‐
figuration

Loads the current configuration of the selected device

Write value Opens a dialogue to change the value of the data
point. Only available for data points with write access

Read value Starts a ready query for the selected data point

Basic settings Opens the Basic settings dialogue
Language Selects the programming language. The OPC server must

be restarted following a language change.

Contents Opens the help function
About... Displays program and version information

2.5.3 Toolbar

A0852

Fig. 21: Toolbar

File menu

A0847

Fig. 17: File menu

Edit menu

A0848

Fig. 18: Edit menu

Settings menu

A0849

Fig. 19: Settings menu

Help menu

A0851

Fig. 20: Help menu

Manual ProMinent OPC-Server
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Icon Description Function

New project Creates a new project, unsaved changes
are lost

Open project Loads an existing project

Save project Saves the current project

Add device Opens the add new device dialogue

Delete device Deletes the selected device from the
project

Load device
configuration

Loads the current configuration of the
selected device

Access device
website

Opens the device website in the web
browser.

Help Opens the help function

2.5.4 Basic settings

A0853

Fig. 22: Basic settings
In basic settings you can define which project should be loaded when the
OPC server is loaded. The default setting is load
[Most recently opened project]. If this option is selected, the last opened or
saved project is loaded. Alternatively you can specify a project which
should always be loaded. To do this, select [Selected project:] and then
click on [Select...] to specify the desired project.

The start option [Invisible when started by OPC client] allows an invisible
start of the OPC server by the OPC client. This makes sense if the user of
the system is not to have direct access to configuration of the OPC server
via the Windows task bar.

The OPC property [Tag delimiter] defines which character is used by the
OPC server to separate the names of the data points. Analogously to the
[Backslash (\)] in a file path the [delimiter] must not occur in data points.
The [delimiter] should only be changed if an OPC client encounters a
problem with the basic default setting.

Manual ProMinent OPC-Server
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2.5.5 Add device

After adding a device, the project must be saved and the
OPC server restarted.
Only after the OPC server is restarted is the OPC name‐
space regenerated and the data points of the new device
updated so that they are visible to the OPC client.

A0854

Fig. 23: Add device
In the add device dialogue, only the [Port] is specified by default. You can
choose any device name. However the [Device name], should not be
changed after commissioning because otherwise the data points in all
linked OPC clients would have to be adapted to match it.

The [Username] and [Password] of the device must be entered as other‐
wise no access to the device data points is possible. The same applies to
the device [IP-Address]. Instead of the [IP-Address] you can also enter the
host name of a device, provided a host name was assigned in the net‐
work.
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2.5.6 Edit device

After editing a device, the project must be saved and the
OPC server restarted.
Only after the OPC server is restarted is the OPC name‐
space regenerated and the changes visible to the OPC
client.

A0855

Fig. 24: Edit device
In the edit device dialogue, the device settings are already specified. The
[Device name] should only be changed if no OPC clients have already
been configured with data points.

Otherwise changing the device name means that OPC clients will no
longer be able to access the device values. For security reasons the
device [Password] is shown only as dots.

Instead of the [IP-Address] you can also enter the [Host name] of a device,
provided a host name was assigned in the network.

2.5.7 Delete device

After deleting a device, the project must be saved and
the OPC server restarted.
Only after the OPC server is restarted is the OPC name‐
space regenerated and the device deletion visible to the
OPC client.

1. Select the device for deletion from the left area of the program
window

2. Click on [Delete device] in the [Edit] menu or click the [-] icon in the
toolbar

3. In response to the query as to whether you really want to delete the
device, click on [Yes]
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2.5.8 Program information (About...)

A0856

Fig. 25: Program information (About...)
You can all the dialogue [About...] from the [Help] menu. The program ver‐
sion and the versions of the OPC toolkit libraries are displayed. If you
require technical support, all three version numbers must be given.
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2.5.9 Status bar

A0857

Fig. 26: Status bar [Loading configuration]

The status bar shows the present program activity.

n The progress bar shows the progress of the current process
n A description of the current work process is displayed directly along‐

side the bar. If an error occurs during a process, an error message is
displayed here.

n The right side of the status bar displays:
– The actual update rate of the selected device
– A countdown to the next value update

Tab. 1: Possible status messages in the status bar:
Status message Explanation

Ready The OPC server is ready for operation

Loading configuration The configuration is being loaded by a device

Processing data The configuration or data points of a device are
being processed

Server available after
restart

Changes were made to the OPC server configu‐
ration and a restart is necessary to implement
the changes. Unsaved changes must be saved
prior to the restart

Updated data points The data points are loaded by the device and
are now updated in the OPC server

Logon The OPC server tries to logon to a device

Logout The OPC server logs off from a device

Error when accessing
the device

The OPC server could not access the device.
For possible reasons, please read trouble‐
shooting Ä Chapter 2.6.1 „Error mes‐
sages“ on page 30 in the appendix

Manual ProMinent OPC-Server
 

  28



2.5.10 Context menus
Right-clicking a device in the tree view displays the corresponding context
menu.

A0858

Fig. 27: Context menu - device menu
You can select the following options from the context menu:

n [Add device]
n [Edit device]
n [Delete device]
Here, Edit and Deleter refer to the currently selected device, which Add
adds a new, independent device.

Right-clicking a data point in the tree view displays the corresponding con‐
text menu.

A0859

Fig. 28: Context menu - data point menu
You can select the following options from the context menu:

n [Read value]
n [Write value]
[Write value] is only available if the data point has the [rw] attribute and
thus can be written to the device.

Device menu

Data point menu
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2.6 Appendix
2.6.1 Error messages
Message Meaning Source

There already exists a
device with this IP address
and port

The configuration already includes a device with this IP address and
port. There can be only one device with the same IP/port combination
per configuration.

Dialogue Add /
Edit device

Enter an IP address The input field for the IP address is blank. The device requires a valid
IP address to enable communication with it.

Enter a device name The input field for the device name is blank. A unique device name is
required for the device to be addressed through the OPC client.

Enter a port. (standard
port: 80)

The input field for the port number is blank. An IP address and the
corresponding port are always required for communication. If you are
unsure, used the default value of 80.

Could not open the file
[example.opc].

The system tried to load a project, but the specified file does not
exist. Check the program settings for the project to be loaded.

Upon program
start, it a project is
to be loaded.

Invalid IP or host address. The IP address or the host name entered in the input field for the
device IP address is invalid or contains invalid characters. A valid IP
address consists of four number groups between 0 and 255 each of
which are separated by a dot each. (Example: 192.168.172.5)

Dialogue Add /
Edit device

Port must be a number
between 1 and 65535.

The entered port number is outside the valid range. Valid port num‐
bers can only be set in the range 1 to 65535.

There already exists a
device with this name

The device name used already exists in the configuration The name
for each device in the configuration must be unique, please select
another name.

Error when accessing the
device

This message is displayed if there were problems accessing the
device. Possible causes: the device is not switched on, the IP
address at the device is incorrectly configured, the IP address in the
server is incorrectly entered or the network is not available.

Main program
window in the
status bar

The OPC namespace was
already initialised. A new
initialisation is only pos‐
sible after reboot of the
server.

The list of the data points or the data point structure in the OPC
server can only be generated once upon starting of the OPC server.
Thereafter no further changes are possible. To load another project
and activate it in the OPC server, the OPC server must be restarted
with this project.

Create new
project, load
project

A client is still connected.
Exiting the server may
cause problems in the
client or server.

Do you want to exit?

The server should in principle only be exited if no OPC clients are
connected to it. However it may happen than an OPC client is unex‐
pectedly closed and no message has been received by the OPC
server to inform it. In this case, the server can be exited by selecting
the option [Yes].

Message when
closing the OPC
server

One or several clients are
still connected. Changes
to the configuration are no
longer possible.

Changes to the OPC server configuration are no longer possible,
once OPC clients are connected to it. Please first disconnect all OPC
client connections and restart the OPC server to make changes to
the configuration.

Create new
project, open
project, add
device, remove
device, edit
device, load
device configura‐
tion

The application has to be
rebooted for the change in
language to become effec‐
tive.

A change in the language settings can only be activated after
restarting the application. Please restart the OPC server to activate
the changed language setting.

Menu settings /
Language
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2.6.2 Support
Should OPC server problems occur, the trace functionality can be used to
make troubleshooting easier for the support team. Support requests
should always be accompanied by the files [trace.txt] and [trace.txt.bak] (if
available). In addition, the program version as well as the version numbers
of both toolkit libraries should be stated. The version numbers are shown
in the Help menu under the option [About...]. The trace file is located in the
program directory of the OPC server corresponding to the directory speci‐
fied during installation.

Trace output is activated as standard, the trace file is created in the pro‐
gramme directory of the OPC server.

1. Open the file [settings.xml] in the programme directory of the OPC
server using any text editor (e.g. Notepad)

2. Search for a line reading as follows: <Trace>false</Trace>

3. Change the setting to [TRUE] to activate the trace output.

or

Change the setting to [FALSE] to deactivate the trace output.

The trace file [trace.txt] is renamed to [trace.txt.bak] as soon as the file
exceeds 256 KB to prevent any the hard disk become overfull. This over‐
writes any possibly already existing [trace.txt.bak].

Trace file

Trace functionality can be activated/deac‐
tivated manually:
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